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Упражнение № 4, 2012
Системи с Програмируема Логика 

Проектиране на Управляващо устройство за светофари като краен автомат с помощта на развойна среда (WebPACK) и входно  HDL – описание
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Целта на настоящото лабораторно упражнение е проектиране, имплементиране върху CPLD – чип и проверка на функционирането на управляващо устройство за светофари на улично кръстовище. Ще използваме развойна среда WebPACK, входен език за описание VHDL и развойна платка  Digilent X-Board.
Проектираното и имплементирано устройство ще управлява светофарна уредба на кръстовище от две улици. Светофарната уредба ще включва и допълнителна функция за мигаща жълта светлина, индицираща временно преустановяване на работата на светофара. 
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Устройството, което ще проектираме и имплементираме върху електрически конфигурируем (програмируем) CPLD – чип, в първата му, опростена версия ще бъде изградено от следните два цифрови блока (устройства):
1) ClkStretcher – блок- генератор на синхронизиращ сигнал с променлива продължителност на тактовите му импулси. 
2) ТrafficLights – цифров блок, представляващ краен автомат, който управлява  състоянията на светлините на светофарите, последователността им на следване и интервалите от  време за оставане във всяко от състоянията; тези времеви интервали се определят от тактовия сигнал на горния модул ClkStretcher.
I. Проектиране на цифров  блок за синхронизация  ClkStretcher


Задачата на този блок е:  използвайки тактов сигнал (от развойната платка) с еднаква продължителност и период на тактовите импулси, да генерира  сигнал с променлива продължителност на тактовите импулси в него. Двата сигнала са показани на следващата времедиаграма  :
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Времева диаграма, изобразяваща входния тактов сигнал и 

генерирания изходен тактов сигнал от блока ClkStrecher
Използването на синхронизиращ сигнал с променлива продължителност на тактовите импулси в него се изисква от физическия принцип на действие на уличните светофари. Той се характеризира със следните състояния:  продължителна фаза, в която единият светофар е в червено а другият - в зелено; краткотрайна фаза, в която светофарите са съответно в червено и жълто състояние; още една краткотрайна фаза, в която светофарите са съответно в жълто и червено състояние. След това логично следва повторение на състоянията на светофарите със смяна на ролите им и т.н. 
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Началото на всяка нова (продължителна или краткотрайна) фаза на светофара, инициирано от управляващия блок ТrafficLights, се задава от поредния нарастващ  фронт на генерирания тактов сигнал с променлива продължителност от синхронизиращия блок ClkStrecher.
Следват стъпките на работа с развойната среда  по създаване на проект  и първия проектен модул в него ClkStretcher.vhd
-  Създайте в папката на вашата група  проект с име TrafficLightsProject. За тази цел:
-  Стартирайте програмната система за проектиране Project Navigator (Xilinx ISE 9.2) чрез:

- иконата Xilinx ISE (Integrated Software Environment) от Desktop
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- Създайте нов проект чрез команда на основното меню:
File => New Project...
- В прозореца New Project Wizard посочете необходимите елементи: име (TrafficLightsProject) и директория на проекта (в папката на вашата група).
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- в полето Project Location чрез бутона за избор посочете папка за проекта; например  C:\VLSI\gr233a;
- запишете името на проекта – TrafficLightsProject в полето Project Name – в папката gr233a ще се създаде папка ТrafficLightsProject за файловете на проекта;
- изберете начин на описание на проектираното устройство, който ще се прилага в главния sourse-модул на проекта – в полето Top-Level Module Type изберете HDL (Hardware Description Language – декларира се използване на език за описание на хардуер);

След натискане на бутона Next преминете към въвеждане на останалите необходими елементи на проекта:
- изберете фамилия от CPLD – чипове, която ще се използва от проекта - Device Family: CoolRunner2 CPLDs; 
- изберете CPLD – чип, върху който ще се реализира устройството - Device: XC2C256;
- изберете вид корпус на чипа - Package: TQ144;
- изберете скорост(бързодействие) на използвания чип -  Speed Grade: -6;
- средството за проектиране на схемата на устройството от езиковото му описание е технологията на синтезиране на цифрова схема XST (VHDL/Verilog) - Xilinx Synthesis Technology , използваща като входен език за описание на устройството езиците от високо ниво VHDL (който  ние ще използваме) .
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- Пропуснете чрез натискане на бутона  Next двата следващи прозореца New Project Wizard, които се използват за създаване и добавяне на сорс-файлове към проекта; ние ще използваме друг начин за включване в проекта на такива файлове.

В прозореца New Project Wizard – Device Properties се извеждат за справка елементите и параметрите на проекта, който  се създава. При несъгласие с някои от тези параметри е възможно връщане към предните стъпки от процедурата на създаване на проекта чрез бутона Back. Бутонът Finish, който трябва да натиснете, на практика създава в избраната директория нужните начални файлове на проекта.
- Създайте source - модул в проекта, съдържащ описанието на проектираното устройство на език VHDL. За тази цел изпълнете от основното меню командите : 
Project => New Source…


- В отворилия се прозорец New Source Wizard изберете тип на модула : VHDL Module , а в полето File name въведете за име на файла, който ще съдържа този модул: ClkStretcher. За да преминете по-нататък, натиснете бутона Next.
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- Пропуснете отново чрез натискане на бутона Next следващия прозорец New Source Wizard- Define Module, чрез който се декларират входните и изходните сигнали (портове) на проектираното устройство. Тези портове ще бъдат декларирани по-късно чрез текста на  VHDL - описанието на устройството.


В прозореца New Source Wizard – Summary се извеждат за справка параметрите на създавания модул. Ако сте съгласни с тях, натиснете Finish, с което на практика се създава в директорията на проекта файлът ClkStretcher.vhd (vhd е разширение в името, означаващо модул/файл с текст на езика VHDL).
В изведения прозорец за редактиране на текста на ClkStretcher.vhd се изобразява текстовата рамка на създадения модул с VHDL – описанието. (Ако прозорецът с текстовата рамка не е показан на екрана, кликнете двойно с мишката върху името на модула ClkStretcher в прозореца Sources на Project Navigator). Изтрийте текстовата рамка и въведете следния VHDL- код, описващ проектираното устройство:
library IEEE;

use IEEE.STD_LOGIC_1164.ALL;

use IEEE.STD_LOGIC_ARITH.ALL;

use IEEE.STD_LOGIC_UNSIGNED.ALL;

entity ClkStretcher is port( 
 

   CLK : in std_logic; -- тактовия сигнал на развойната платка
                             OutCLK : inout std_logic; -- продуцирания изходен сигнал


   Reset : in std_logic; -- сигнал за начална инициализация


   Blink : in std_logic -- сигнал за мигащата жълта светлина


);

end ClkStretcher;

architecture Behavioral of ClkStretcher is

signal enable1 : std_logic; -- стартира генерирането на дългия пулс
signal enable2 : std_logic; -- стартира генерирането на първия кратък пулс след всеки дълъг
signal enable3 : std_logic; -- стартира генерирането на втория кратък пулс след всеки дълъг
signal enable4 : std_logic; -- стартира секцията необходима за мигащата жълта светлина
signal counter1 : std_logic_vector(7 downto 0); -- определя дължината на дългия пулс
signal counter2 : std_logic_vector(3 downto 0); -- определя продължителността на първия тактов пулс
signal counter3 : std_logic_vector(3 downto 0); -- определя продължителността на втория тактов пулс 
signal counter4 : std_logic_vector(3 downto 0); -- определя честотата на мигане на жълтата светлина
begin

process(Reset, CLK, Blink)

begin

if(Reset = '1') then -- при начално установяване се активира първата секция генерираща дългия пулс
  enable1<='1';

  enable2<='0';

  enable3<='0';

  enable4<='0';

  counter1<=(others=>'0'); -- нулиране на всички броячи
  counter2<=(others=>'0');

  counter3<=(others=>'0');

  counter4<=(others=>'0');

  OutCLK<='0';

 elsif(CLK'event and CLK='1') then

       if(enable1='1') then --  секция за активиране само на първия брояч 
           counter1<=counter1+1; 



 if(counter1<"00001111")then OutCLK<='1';  -- начало/високо ниво на OutCLK


   elsif(counter1="00010000") then 

            


enable1<='0';                   -- секцията се заключва и край на първия пулс
            


counter1<=(others=>'0'); -- нулиране на първия брояч
            


enable2<='1';                   -- стартиране на следващата секция
            


enable3<='0';                   -- секцията е непозволена



enable4<='0';                   -- секцията за мигащата жълта светлина е непозволена



OutCLK<='0';                   -- OutCLK пада в ниско състояние


   else OutCLK<='0';
                     -- OutCLK пада в ниско състояние
       end if;

       elsif(enable2='1') then --  секция за активиране само на втория брояч
              counter2<=counter2+1;


  if(counter2<"0111")then OutCLK<='1'; -- начало/високо ниво на OutCLK


  elsif(counter2="1111") then

            


enable1<='0'; -- секцията е непозволена



enable2<='0'; -- секцията се заключва и край на втория пулс
            


counter2<=(others=>'0'); -- нулиране на втория брояч
            


enable3<='1'; -- стартиране на следващата секция



enable4<='0'; -- секцията за мигащата жълта светлина е непозволена  




OutCLK<='0'; -- OutCLK пада в ниско състояние


  else OutCLK<='0'; -- OutCLK пада в ниско състояние


        end if;

   elsif(enable3='1') then --  секция за активиране само на третия брояч
        counter3<=counter3+1; 



if(counter3<"0111")then OutCLK<='1'; -- начало/високо ниво на OutCLK


elsif(counter3="1111") then

            


enable3<='0'; -- секцията се заключва и край на третия пулс
            


counter3<=(others=>'0');  -- нулиране на третия брояч
            


enable1<='0'; -- секцията е непозволена
            


enable2<='0'; -- секцията е непозволена



enable4<='1'; -- секцията за мигащата жълта светлина е позволена



OutCLK<='0'; -- OutCLK пада в ниско състояние


else OutCLK<='0';  -- OutCLK пада в ниско състояние
             end if;


elsif(enable4='1') then -- секция за мигащата светлина и активиране само на четвъртия брояч

counter4<=counter4+1;
       ------- проверка дали сигнала отговарящ за мигащата жълта светлина е активен

       if(Blink='0') then -- Ако Blink е неактивен
            


 OutCLK<='0'; -- OutCLK пада в ниско състояние



enable1<='1'; -- секция 1 се отключва



enable2<='0'; -- секция 2 е заключена



enable3<='0'; -- секция 3 е заключена



enable4<='0'; -- секция 4 е заключена



counter4<=(others=>'0'); -- нулиране на четвъртия брояч

        elsif(Blink='1') then -- Ако Blink е активен



  


OutCLK<=counter4(3); -- продуцираме делител на честота

       end if;
        end if; -- край на секцията с enablе… 
   end if; -- край на секцията отговорна за Reset и CLK
end process;

end Behavioral;
           Кратки  пояснения към горния VHDL  - код, описващ цифровия блок ClkStrecher:
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Изходният тактов сигнал с променлива продължителност, описан в горния текст, се генерира посредством изходните сигнали на три брояча на входните импулси от развойната платка. Броячите са един 8-битов – counter1 и два 4-битови – counter2 и counter3 , отговарящи за отделните изходни импулси с различна продължителност. Освен това се използват и три еднобитови флагове(сигнали) – enable1, enable2, enable3, които се изключват взаимно и определят кой от трите изходни импулса в дадения момент да се генерира .


Блокът ClkStretcher използва освен изброените по - горе цифрови възли, още и един 4 – битов брояч (counter4) и еднобитов флаг – enable4. Те са необходими за генерирането на „къси” импулси с еднаква продължителност и честота, управляващи мигащата жълта светлина, индицираща временното преустановяване на работа на светофарната уредба.

- Актуализирайте съдържанието на файла чрез File => Save. 
- Изпълнете процесите на проектиране на блока. За тази цел в прозореца Processes for Current Source (при избран сорс-модул  ClkStretcher в прозореца Sources in Project) двойно кликнете върху последния процес: Generate Programming File. Развойната среда ще изпълни  процесите на проектиране в необходимата последователност.

II. Проектиране на цифров блок с управляващ краен автомат  ТrafficLights
Както бе споменато по-горе, модулът ТrafficLights описва краен автомат, управляващ състоянията на светлините на светофарите на проектираното устройство и последователността им на следване. Графът, описващ преходите на крайния автомат съдържа 8 върха, представящи състоянията на  светофарите за кръстовище на две улици при нормално функциониране, а също и при функциониране с мигащи жълти светлини. 
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Вид на графа, описващ крайния автомат за устройството ТrafficLights
Следват стъпките на работа с развойната среда по създаване на проектен модул ТrafficLights.vhd, описващ блока с управляващия краен автомат:
- Създайте нов VHDL – модул в проекта чрез командите от главното меню Project => New Source..., в отворилия се прозорец New Source Wizard  изберете за тип на модула: VHDL Module, а за име: TrafficLights.
В изведения прозорец за редактиране на текста на TrafficLights.vhd се изобразява текстовата рамка на създадения VHDL –модул. (Ако прозорецът с текстовата рамка не е показан на екрана, кликнете двойно с мишката върху името на модула TrafficLights в прозореца Sources на Project Navigator). 
-  Изтрийте текстовата рамка и въведете следния VHDL код, описващ функциониране според графа на преходите и изходите на управляващия краен автомат:

library IEEE;

use IEEE.STD_LOGIC_1164.ALL;

use IEEE.STD_LOGIC_ARITH.ALL;

use IEEE.STD_LOGIC_UNSIGNED.ALL;

---- Uncomment the following library declaration if instantiating

---- any Xilinx primitives in this code.

--library UNISIM;

--use UNISIM.VComponents.all;

entity TrafficLights is


port (
                             

         CLK : in std_logic;  -- тактовият сигнал, който ще идва от модула ClkStretcher




Reset : in std_logic; -- входен сигнал за начално установяване




Blink : in std_logic; -- сигнал отговарящ за мигащата жълта светлина



   
R1 : out std_logic;   -- сигнал за червената светлина на светофар 1




Y1 : out std_logic;   -- сигнал за жълтата светлина на светофар 1




G1 : out std_logic;   -- сигнал за зелената светлина на светофар 1




R2 : out std_logic;   -- сигнал за червената светлина на светофар 2




Y2 : out std_logic;   -- сигнал за жълтата светлина на светофар 2




G2 : out std_logic;   -- сигнал за зелената светлина на светофар 2




OutDouble : out std_logic -- контролен изходен сигнал, който повтаря CLK

         );

end TrafficLights;

architecture Behavioral of TrafficLights is


type state_type is (s1,s2,s3,s4,s5, s6, s7,s8); -- дефинираме потребителски тип


signal state , nextstate : state_type ;     -- необходим за състоянията на графа

begin

process1: process (CLK,Reset)  -- процес, необходим за началното установяване на крайния автомат
                                                    --  начално състояние след Reset – s1  
begin

  if (Reset ='1') then 




state <=s1; 

  elsif (CLK='1' and CLK'event) then

      state <= nextstate;

  end if;

end process process1;

process2: process (state, Reset, Blink) -- процес, управляващ преходите                                   

begin



            -- между отделните състояния и условията за тях
case state is


when s1 => if (Reset='1') then




nextstate <= s1;











      elsif
(Reset='0')  then 




nextstate <= s2;



         end if;

 
when s2 =>  nextstate <= s3; 

   
when s3 =>  if(Blink='0') then


              
nextstate <= s4;

              
       elsif(Blink='1') then

                                        nextstate <= s7;



       end if;
  

   
when s4 =>  nextstate <= s5; 


when s5 =>  nextstate <= s6; 

when s6 => if(Blink='0') then


                        nextstate <= s1;

                                 elsif(Blink='1') then

                                     nextstate <= s7;



       end if;

----------- секция,  отговорна за мигащата жълта светлина 

when s7 => if(Reset='0' and Blink='1') then 


           

nextstate <= s8;


                    elsif(Reset='1') then 




  nextstate <= s1;

            

       elsif(Reset='0' and Blink='0') then


  




  nextstate <= s2;



       end if;


when s8 => if(Reset='0' and Blink='1') then 


           

nextstate <= s7;



       elsif(Reset='1') then 




nextstate <= s1;



       elsif(Reset='0' and Blink='0') then


  




nextstate <= s2;



       end if;

end case;

end process process2;

process3 : process (CLK, state) -- процес, управляващ изходните сигнали на крайния автомат
begin                                          -- тук се посочва какво да се управлява
                         -- когато автоматът се намира във всяко от възможните си състояния
if (CLK='1' and CLK'event) then 

case state is

when s1 => R1<='1'; Y1<='0'; G1<='0'; R2<='0'; Y2<='0'; G2<='1';

when s2 => R1<='1'; Y1<='0'; G1<='0'; R2<='0'; Y2<='1'; G2<='0';

when s3 => R1<='0'; Y1<='1'; G1<='0'; R2<='1'; Y2<='0'; G2<='0';

when s4 => R1<='0'; Y1<='0'; G1<='1'; R2<='1'; Y2<='0'; G2<='0';

when s5 => R1<='0'; Y1<='1'; G1<='0'; R2<='1'; Y2<='0'; G2<='0';

when s6 => R1<='1'; Y1<='0'; G1<='0'; R2<='0'; Y2<='1'; G2<='0';

when s7 =>  if(Blink='1') then 

               
R1<='0'; Y1<='1'; G1<='0'; R2<='0'; Y2<='1'; G2<='0';


       else



R1<='1'; Y1<='0'; G1<='0'; R2<='0'; Y2<='0'; G2<='1';


       end if;


when s8 =>  if(Blink='1') then 

            

R1<='0'; Y1<='0'; G1<='0'; R2<='0'; Y2<='0'; G2<='0';


       else



R1<='1'; Y1<='0'; G1<='0'; R2<='0'; Y2<='0'; G2<='1';


       end if;

end case;

end if;

end process process3;

OutDouble<=CLK;

end Behavioral;


Кратки  пояснения към горния VHDL - код, описващ цифровия блок (управляващ краен автомат) TrafficLights.
Това управляващо устройство излъчва 3 двойки изходни сигнали (R1 и R2, Y1 и Y2, G1 и G2) отговарящи  за светлините на светофарите, приема входен сигнал Blink, необходим за определяне дали е стартирана мигащата жълта светлина и входен синхронизиращ сигнал CLK с различна продължителност на импулсите, генериран от другия блок, описан в проекта -  ClkStretcher.

За описание на устройството е използвана поведенческа архитектура (с процеси - process), които в случая са три. Състоянията на крайния автомат (8 на брой) са представени като стойности на два сигнала ( state и nextstate) ot потребителски дефиниран тип state_type чрез конструкцията:   
                                type state_type is (s1,s2,s3,s4,s5, s6, s7,s8); 


                  signal state , nextstate : state_type ;
В първия процес се извършва асинхронна инициализация на устройството и се определя преминаването от едно състояние на крайния автомат в друго да се извършва по нарастващия фронт на тактовия сигнал CLK. 
Вторият процес управлява последователността на преходите между отделните състояния, както и условията за тези преходи (описва функцията на преходите на крайния автомат).

Третият процес е отговорен за управлението на светлинната индикация (описва функцията на изходите на крайния автомат). В него с  високи и ниски нива (цифрова ‘1’ и цифрова ‘0’ ) на съответните изходни сигнали (R1 и R2, Y1 и Y2, G1 и G2) се  управляват светлините – при ‘1’ – светят, при ‘0’ - не.

· Актуализирайте съдържанието на файла TrafficLights.vhd  чрез File => Save. 
----------------------------------------------------------------------------------------------------------------------------------------------

[image: image9.png]



Светофар в джунглите на Нова Каледония; папагалите в него са специално дресирани

--------------------------------------------------------------------------------------------------------------------------------------------------
III. Добавяне на главен модул  на проекта -  GeneralModule
Чрез този главен модул на проекта се описва структурата на устройство, съставено от описаните досега два блока - ClkStrecher и TrafficLights.

Следват стъпките на работа с развойната среда по създаване на главния модул на проекта GeneralModule:

- Създайте нов VHDL – модул в проекта чрез командите от главното меню Project => New Source..., в отворилия се прозорец New Source Wizard  изберете за тип на модула: VHDL Module, а за име: GeneralModule. 
-  В следващия прозорец New Source Wizard- Define Module, чрез който се декларират входните и изходните сигнали (портове) на проектираното устройство посочете за име на архитектурата Architecture Name: Structural. За да преминете по-нататък, натиснете бутона Next.
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В прозореца New Source Wizard – Summary се извеждат за справка параметрите на създавания модул. Натиснете Finish, с което на практика се създава в папката на проекта файлът GeneralModule.vhd (да припомним, vhd е разширение в името, означаващо модул/файл с текст на езика VHDL).
В изведения прозорец за редактиране на текста на GeneralModule.vhd се изобразява текстовата рамка на създадения модул с VHDL – описанието. Изтрийте текстовата рамка и въведете следния VHDL-код, описващ проектираното устройство, съставено от двата блока:
library IEEE;

use IEEE.STD_LOGIC_1164.ALL; 

use IEEE.STD_LOGIC_ARITH.ALL;

use IEEE.STD_LOGIC_UNSIGNED.ALL;

entity GeneralModule is


port(

         BoardCLK : in std_logic;


Reset : in std_logic; 


Blink : in std_logic;


R1 : out std_logic;


Y1 : out std_logic;


G1 : out std_logic;


R2 : out std_logic;


Y2 : out std_logic;


G2 : out std_logic;

         OutDouble : out std_logic );

end GeneralModule;

architecture Structural of GeneralModule is
component ClkStretcher 

port(    CLK : in std_logic;

         OutCLK : inout std_logic;


Reset : in std_logic;


Blink : in std_logic


 );

end component;
component TrafficLights

port(   CLK : in std_logic;


Reset : in std_logic; 


Blink : in std_logic;


R1 : out std_logic;


Y1 : out std_logic;


G1 : out std_logic;


R2 : out std_logic;


Y2 : out std_logic;


G2 : out std_logic;


OutDouble : out std_logic

         ); 

end component;

signal Intermed : std_logic; -- вътрешен сигнал за предаване на тактовия сигнал от ClkStrecher

                                             --към TrafficLights
begin



in1: ClkStretcher port map(CLK=>BoardCLK,OutCLK=>Intermed,Reset=>Reset,Blink=>Blink);


in2: TrafficLights port map(CLK=>Intermed,Reset=>Reset,Blink=>Blink,R1=>R1,Y1=>Y1,G1=>G1,R2=>R2,Y2=>Y2,G2=>G2,OutDouble=>OutDouble);

end Structural;

В проекта главният модул GeneralModule описва архитектурата на  устройство, съставено от декларирани два блока (компонента): ClkStretcher и TrafficLights, които са описани в съответните, подчинени на главния модули.
- Актуализирайте съдържанието на файла чрез File => Save. 
В прозореца  Sources на Project Navigator получавате следния вид на досега включените елементи в проекта:
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- Изпълнете процесите на проектиране на устройството. За тази цел:

- В прозореца Processes for Current Source (при избран сорс-модул GeneralModule в прозореца Sources in Project) разширете Implement Design и двойно кликнете върху последния процес: Generate Programming File. Системата за проектиране ще изпълни всички процеси на проектиране в необходимата последователност.

Разгледайте генерирания CPLD - Report, който се появява след успешно изпълнение на процесите по проектиране. Той основно описва процентите на заети ресурси от различен вид в CPLD – чипа:
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- Проверете като резултат от проектирането синтезираната  цифрова и логическа схема на цялостното устройство, чрез двойно кликване на Synthesize -> View RTL Schematics и влизане в по-ниските нива на схемата – отново чрез двойно кликване с левия бутон, когато курсорът на мишката е върху блок от схемата:
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RTL- схема с най-високо ниво на главния модул
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По-подробна RTL- схема, синтезирана от главния модул, на която са показани двата блока, от които е съставено устройството
--------------------------------------------------------------------------------------------------------------------------------------
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светофар от тип “в търсене на изгубеното време”
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светофар от провинция Квебек, Канада

----------------------------------------------------------------------------------------------------------------------------------------
IV. Симулиране на работата на устройството
- Зададайте т.нар. входни стимули (определящи стойностите на входните сигнали във времето на симулацията).  За тази цел:

- Създайте нов source - модул(файл) в проекта, който ще съхранява информацията за стимулите. За тази цел изпълнете, като започнете от главното меню на развойната среда командите: Project =>New Source… 

- В отворилия се прозорец New Source задайте за тип на source – модула със стимулите  Test Bench Waveform, а за име на модула -  ТestGeneral : 
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-  Преминете нататък  с бутона Next.
- В следващия отворил се прозорец New Source Wizard – Associate Source трябва да потвърдите, че създаваният в момента source - модул от тип Test Bench Waveform ще бъде асоцииран (подчинен) на главния VHDL – модул на проекта - GeneralModule. Би трябвало GeneralModule да е отбелязан в прозореца и в такъв случай ще преминете нататък  с бутона Next.

- В отворилия се прозорец New Source Wizard – Summary развойната среда извежда обратно информация за новосъздадения source - модул TestGeneral.tbw с цел проектантът да провери за грешки. Потвърдете тази информация с бутона Finish.

- В отворилия се прозорец  Initial Timing and Clock Wizard – Initialize Timing потвърдете или въведете нови времеви параметри на управляващите симулацията входни за устройството сигнали и на тактовия му сигнал, както са показани на фигурата по – долу и след като ги коригирате, натиснете Finish:
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В прозореца за редактиране на развойната среда се появява основният прозорец за въвеждане на графична информация в Test Bench Waveform – модула. 
-  Задайте начален установяваща импулс за входния сигнал Reset.
- Задайте стойност ‘0’ за входния управляващ сигнал Blink (за нормална работа на светофарите) – всъщност би трябвало тази стойност да бъде установена от средата по премълчаване:
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- Запишете въведената от вас графична информация във файла TestGeneral.tbw  чрез иконата Save File   [image: image20.png]


 от главното меню на Project Navigator  

- В прозореца Sources въведете чрез падащотото меню Sources For... режим на работа на развойната среда  Post-Fit Simulation; Тя ще трябва да извърши симулация с отчитане на електрическите и времеви параметри на реално реализираното устройство върху чипа.
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 В  прозореца Sources ще  се появи новият source - модул на проекта TestGeneral.tbw  :

[image: image22.png]Sources
Sources for. | PostFit Simulation

Tl igheoard
s e
TestGeneral (TestGeneral thw)






- Стартирайте симулатора ISE Simulator и проверете резултатите от симулацията. За тази цел:


- Активирайте (ако не е вече активиран) в горния прозорец (Sources) модула със стимулите TestGeneral.tbw , управляващ симулацията ; 

- Активирайте панела Processes в прозореца Processes на Project Navigator; Разширете списъка от команди към симулатора Xilinx ISE Simulator (ако не е вече разширен);
:
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-Установете  върху лентата с инструменти на средата интервал от време за симулация 3000 ns:
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- Стартирайте с двойно кликване командата Simulate Post - Fit  Model. При правилна досегашна работа ще се стартира симулаторът Xilinx ISE Simulator и неговият прозорец с времедиаграми на входните и изходни сигнали ще се изобрази на екрана. 
Чрез поставяне на маркер върху получените времедиаграми ( Simulation => Markers => Single Marker...) можете да проследите в какви състояния са светофарите във всеки момент от симулацията. Например на долната диаграма в момента на маркера  R1 = ‘1’, Y1 = ‘0’, G1 = ‘0’;  R2 = ‘0’, Y2 = ‘0’, G2 = ‘1’ – в този момент за първи светофар свети “червено”, а за втори – “зелено”:
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Можете да проследите времедиаграмите (стойностите на сигналите) и след 1000 ns, като изпълните: Simulation => Run For Specified Time...
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Затворете прозореца на симулатора с времедиаграмите на сигналите и извършете симулация на работата на устройството при входен управляващ сигнал Blink = ‘1’ (задаващ с тази си стойност мигащи жълти светлини, а останалите светлини на светофарите би трябвало да са изключени):
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- Затворете прозореца на симулатора с времедиаграмите на сигналите и отново преминете в режим на работа на развойната среда Sources for:  Synthesis/Implementation.
------------------------------------------------------------------------------------------------------------------------------
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Вляво: Странни светещи кълба, заснети от сондата  Вояджър-4 над Йо, спътник на Юпитер;  Вдясно: Според д-р Евгения Лопес от НАСА, това образувание най-вероятно е космически светофар, въпреки че потребителите му все още не са известни.
-----------------------------------------------------------------------------------------------------------------------------------
Въведеният в проекта  VHDL код  в модула ClkStretcher.vhd няма да бъде използван в този му вид при крайната реализация на  проектираното устройство, тъй като времената, който за зададени в него (чрез размера на броячите и константните стойности за сравнение) са от порядъка на ns, а за практическата работа на устройството са твърде малки интервали. Това бе направено досега, за да може да се симулира и да се провери коректността на работа на устройството. 
Необходими са малки  корекции в VHDL кода (основно увеличаване на крайните стойност на броячите, споменати по-горе), които ще доведат до увеличаване на интервалите от време при работа на устройството до няколко секунди. За тази цел :
- Отворете прозореца с текста (VHDL- кода) на ClkStretcher.vhd чрез двойно кликване върху модула ClkStretcher.vhd в прозореца Sources на Project Navigator. Изтрийте текста в него, (който по-рано бе въведен) и въведете следния текст с увеличени крайни стойности на броячите:
library IEEE;

use IEEE.STD_LOGIC_1164.ALL;

use IEEE.STD_LOGIC_ARITH.ALL;

use IEEE.STD_LOGIC_UNSIGNED.ALL;

entity ClkStretcher is port( 
 

   CLK : in std_logic; -- тактовия сигнал на развойната платка
                             OutCLK : inout std_logic; -- продуцирания изходен сигнал


   Reset : in std_logic; -- сигнал за начална инициализация


   Blink : in std_logic -- сигнал за мигащата жълта светлина


);

end ClkStretcher;

architecture Behavioral of ClkStretcher is

signal enable1 : std_logic; -- стартира генерирането на дългия пулс
signal enable2 : std_logic; -- стартира генерирането на първия кратък пулс след всеки дълъг
signal enable3 : std_logic; -- стартира генерирането на втория кратък пулс след всеки дълъг
signal enable4 : std_logic; -- стартира секцията необходима за мигащата жълта светлина
signal counter1 : std_logic_vector(31 downto 0); -- определя дължината на дългия пулс
signal counter2 : std_logic_vector(24 downto 0); -- определя продължителността на първия тактов пулс
signal counter3 : std_logic_vector(24 downto 0); -- определя продължителността на втория тактов пулс 

signal counter4 : std_logic_vector(24 downto 0); -- определя честотата на мигане на жълтата светлина
begin

process(Reset, CLK, Blink)

begin

if(Reset = '1') then -- при начално установяване се активира първата секция генерираща дългия пулс
  enable1<='1';

  enable2<='0';

  enable3<='0';

  enable4<='0';

  counter1<=(others=>'0'); -- нулиране на всички броячи
  counter2<=(others=>'0');

  counter3<=(others=>'0');

  counter4<=(others=>'0');

  OutCLK<='0';
elsif(CLK'event and CLK='1') then

       if(enable1='1') then --  секция за активиране само на първия брояч 
           counter1<=counter1+1; 



 if(counter1<x"1FFFFFFF")then OutCLK<='1';  -- начало/високо ниво на OutCLK


elsif(counter1=x"1FFFFFFF" + 1) then 

            


enable1<='0';                   -- секцията се заключва и край на първия пулс
            


counter1<=(others=>'0'); -- нулиране на първия брояч
            


enable2<='1';                   -- стартиране на следващата секция
            


enable3<='0';                   -- секцията е непозволена



enable4<='0';                   -- секцията за мигащата жълта светлина е непозволена



OutCLK<='0';                   -- OutCLK пада в ниско състояние


   else OutCLK<='0';
                     -- OutCLK пада в ниско състояние
       end if;

       elsif(enable2='1') then --  секция за активиране само на втория брояч
              counter2<=counter2+1;


  if(counter2<x"1000000")then OutCLK<='1'; -- начало/високо ниво на OutCLK



  elsif(counter2=x"1FFFFFF") then

            


enable1<='0'; -- секцията е непозволена



enable2<='0'; -- секцията се заключва и край на втория пулс
            


counter2<=(others=>'0'); -- нулиране на втория брояч
            


enable3<='1'; -- стартиране на следващата секция



enable4<='0'; -- секцията за мигащата жълта светлина е непозволена  




OutCLK<='0'; -- OutCLK пада в ниско състояние


  else OutCLK<='0'; -- OutCLK пада в ниско състояние


        end if;

   elsif(enable3='1') then --  секция за активиране само на третия брояч
        counter3<=counter3+1; 



if(counter3<x"1000000")then OutCLK<='1'; -- начало/високо ниво на OutCLK



elsif(counter3=x"1FFFFFF") then

            


enable3<='0'; -- секцията се заключва и край на третия пулс
            


counter3<=(others=>'0');  -- нулиране на третия брояч
            


enable1<='0'; -- секцията е непозволена
            


enable2<='0'; -- секцията е непозволена



enable4<='1'; -- секцията за мигащата жълта светлина е позволена



OutCLK<='0'; -- OutCLK пада в ниско състояние


else OutCLK<='0';  -- OutCLK пада в ниско състояние
             end if;


elsif(enable4='1') then -- секция за мигащата светлина и активиране само на четвъртия брояч

counter4<=counter4+1;
       ------- проверка дали сигналът, отговарящ за мигащата жълта светлина е активен

       if(Blink='0') then -- Ако Blink е неактивен
            


 OutCLK<='0'; -- OutCLK пада в ниско състояние



enable1<='1'; -- секция 1 се отключва



enable2<='0'; -- секция 2 е заключена



enable3<='0'; -- секция 3 е заключена



enable4<='0'; -- секция 4 е заключена



counter4<=(others=>'0'); -- нулиране на четвъртия брояч

        elsif(Blink='1') then -- Ако Blink е активен



  


OutCLK<=counter4(24); -- продуцираме делител на честота

       end if;
        end if; -- край на секцията с enablе… 
   end if; -- край на секцията отговорна за Reset и CLK
end process;

end Behavioral;
        
- След като нанесете описаните промени, актуализирайте съдържанието на файла ClkStretcher.vhd (File  => Save ...)   и стартирайте наново процесите на проектиране (чрез Generate Programming File...) .
- За да можете да стартирате работата и проверите функционирането на проектираното устройство върху зададения CPLD – чип на развойна платка, задайте ограничения в работата на развойната среда при работата й при проектиране на устройството, а именно  - задайте вашите изисквания за разполагане на входните и изходни сигнали на устройството върху точно определени изводи на чипа, така че тези сигнали да управляват или да бъдат управлявани от определени елементи (ключове, бутони, светодиоди) на платката. За тази цел : 
- Добавете в проекта нов source - UCF – модул с име GlobalUCF, (Project => New Source… и от прозореца New Source Wizard избор за тип модул Implementation Constraints File и File name => GlobalUCF). 

След това  включване на модул в проекта, прозорецът Sources на развойната среда, показващ всички досега включени модули на проекта, трябва да изглежда така:
[image: image29.png]Sources.

‘Sources for:| Synthesis/implementation

 TraffclghtsProject
5 E1xc2c2566TQ144
5 [ GeneralModue - Sructural (GeneralModule.vhd)
[m1 - CkStetcher - Behaviorl (CkSiretcher vhd)
[in2 - TrfficLihts - Behavioral (TrfficLights vhd)
] GlobalLUCF wcf (GobalLICF uch)






- Активирайте в горния прозорец UCF – модула, след което в прозореца Processes разширете User Constraints и от разширението кликнете двойно върху Assign Package Pins; 
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Стартира се програмата  Pace от развойната среда, чрез която можете да присвоите изводи от чипа на входно/изходните сигнали на проектирaното устройство;

- Попълнете колоната Loc(ation) на таблицата на  Pace, както е дадена по-долу; В тази таблица имената на изводите на чипа, върху които искаме да бъдат разположени сигналите, се записват в колоната Loc(ation):
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Запишете тази информация в UCF – файла чрез Save...
 Ако развойната среда изобрази показания по-долу прозорец, потвърдете  чрез радиобутона, показан по-долу, че пречупените скоби се използват за индексиране на сигналите в таблицата:
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- Активирайте главния VHDL – модул на проекта (General Module) и стартирайте до край (чрез стартиране на  Generate Programming File) процесите на проектиране.
V. Имплементиране на устройството за управление на светофари върху CPLD - чип  на развойна платка и проверка на работата му

Свържете развойната платка към компютъра, на който е развойната среда WebPACK, с помощта на кабела за  USB – интерфейс. Но преди това е полезно да прочетете следващия абзац:
Внимание! Конфигурирането на CPLD – чиповете е енергонезависимо, тоест, то се запазва в чиповете, независимо от изключването на захранващото им напрежение.
Като свържете развойната платка с CPLD – чипа към компютъра, той по USB ще подаде към нея захранващо напрежение. При това положение, ще се стартира автоматично някакво управляващо устройство, конфигурирано от ваш колега по време на  предно упражнение – и резултатите  могат да бъдат изумителни и необясними! Затова включвайте внимателно, след взети всички предпазни мерки.( И още един съвет – не правете това сами, когато сте  вкъщи).
----------------------------------------------------------------------------------------------------------------------------------------------

След успешното и  спокойно включване на платката към компютъра: 
- Заредете получения от развойната среда файл за конфигуриране (Programming File) в CPLD – чипа на развойната платка. За тази цел:

- Стартирайте програмата: Digilent => Adept => ExPort  ( от списъка AllPrograms или от икона на Desktop );

- В прозореца на ExPort първоначално стартирайте Initialize Chain, и след проверката на USB - връзката между компютъра и развойната платка, която ще извърши Export, в прозореца ще се изобрази чипа от развойната платка, който може да бъде конфигуриран (програмиран):
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Важно!!! За да е възможно програмирането (конфигурирането) от вас на CPLD - чипа върху развоната платка, е необходимо съответният ключ на платката  да е в режим PROG. В противен случай няма и да се визуализира чипът с надпис CPLD, който е показан в горния прозорец.
- Кликнете върху изображението на CPLD - чипа XC2C256,  който сте задали в началото на декларирането на проекта да бъде използван за имплементирането на устройството и в който трябва да заредите файла за конфигуриране. 
- Намерете чрез бутона Browse в прозореца на CPLD - чипа XC2C256,   идентификатора на файла за конфигуриране (програмиране) от папката на вашия проект (би трябвало да е с идентификатор GeneralModule.jed).

- Прехвърлете файла за конфигуриране в CPLD - чипа чрез бутона Program Chain.
    - Проверете работата на имплементираното устройство върху развойната платка X-Board.
С помощта на зададеното от вас по-горе чрез програмата PACE и файла GlobalUCF.usf разполагане на входно/изходните сигнали върху изводите на чипа, работата на проектираното и имплементирано устройство за управление на светофарите на улично кръстовище (GeneralModule) ще се управлява и контролира от следните елементи на платката:
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Променете комбинациите на светлините в различните фази на светофарите така, че да отговарят на използваните по кръстовищата  у нас. (Например след червена светлина би трябвало да светват червена и жълта светлина, не само жълта...). За тази цел:

· Направете промени в текста на модула TrafficLights.vhd , описващ функцията на изходите на управляващия краен автомат;
· Запишете промените в текста на TrafficLights.vhd;

· Стартирайте отново процесите на проектиране на устройството;
· Конфигурирайте наново CPLD - чипа (с новото съдържание на файла за конфигуриране GeneralModule.jed и проверете новото функциониране на устройството.
-------------------------------------------------------------------------------------------------------------------------------------------
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Вляво: Студентите от група 333а монтират проектираното от тях управляващо устройство за светофари на кръстовище; Вдясно: Резултат от 3 – минутната работа на устройството.
----------------------------------------------------------------------------------------------------------------------------------------------
В  упражнението по-нататък ще проектираме и имплементираме върху CPLD – чип втора версия на  създаденото устройство за управление на светофарна уредба на кръстовище. Тя  ще управлява и индикация на седем-сегментни индикаторни елементи  за оставащото време до края на основните фази на свтофара (червено/зелено). Ще реализираме и управление на светофари за пешеходците: 
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Нов вид и организация на светофарната уредба на улично кръстовище
VI.  Проектиране на устройство за управление на светофари със седем-сегментна индикация и  пешеходни светофари
Промяна на кода в  главния модул на проекта  – GeneralModule

- Кликнете двойно с мишката върху името на модула GeneralModule.vhd  в прозореца Sources на Project Navigator  - текстът му ще се изобрази върху прозореца за редактиране. Изтрийте досегашния текст  и въведете следния VHDL код, описващ новата версия на проектираното устройство:
library IEEE;

use IEEE.STD_LOGIC_1164.ALL; 

use IEEE.STD_LOGIC_ARITH.ALL;

use IEEE.STD_LOGIC_UNSIGNED.ALL;

entity GeneralModule is


port(

         BoardCLK : in std_logic;




Reset : in std_logic; 




Blink : inout std_logic;



   
R1 : out std_logic;




Y1 : out std_logic;




G1 : out std_logic;




R2 : out std_logic;




Y2 : out std_logic;




G2 : out std_logic;




OutDouble : out std_logic;




-- сигнали за управление на пешеходните светофари




R_W1 : out std_logic;




G_W1 : out std_logic;




R_W2 : out std_logic;




G_W2 : out std_logic;




-- сигнали за управление на 7-сегментните индикатори




-- (катода и анодите)



  
CAT: out std_logic; 

        

 
AA: out std_logic; 




AB: out std_logic; 




AC: out std_logic; 



   
AD: out std_logic; 



   
AE: out std_logic; 



   
AF: out std_logic; 



   
AG: out std_logic




------------------------







);

end GeneralModule;

architecture Structural of GeneralModule is

component ClkStretcher 

port(    



CLK : in std_logic;

         

OutCLK : inout std_logic;


      
Reset : in std_logic;



Blink : inout std_logic;



-- целочислена стойност, необходима за



-- брояча за обратно отброяване на 



-- продължителността на зелените/червените



--фази на светофара



Count_Int_Time : inout integer range 0 to 31






 );

end component;

component TrafficLights

port(    




CLK : in std_logic;




Reset : in std_logic; 




Blink : in std_logic;




R1 : out std_logic;




Y1 : out std_logic;




G1 : out std_logic;




R2 : out std_logic;




Y2 : out std_logic;




G2 : out std_logic;




-- сигналите за управление на




-- пешеходните светофари  се добавят




-- в крайния автомат, където става тяхното




-- управление




R_W1 : out std_logic; 




G_W1 : out std_logic;




R_W2 : out std_logic;




G_W2 : out std_logic;




-- Сигнал за управление на катода на сегментите




-- При зелена фаза на единия




-- светофар ще е активен само единия сегмент,




-- на който ще се визуализира обратното отброяване.




-- При зелена фаза на другия светофар - съответно




-- другият сегмент ще е активен 




CAT_Change : out std_logic;




----------------------




OutDouble : out std_logic

         ); 

end component;




-- компонент необходим за трансформиране на 




-- стойността на брояча за обратно отброяване




-- към сигналите управляващи анодите на седем-




-- сегментните индикатори за визуализация. 

component HexToSevenSegment

port(


HEX:   in    STD_LOGIC_VECTOR (3 downto 0);

        
LED:   out   STD_LOGIC_VECTOR (6 downto 0)


 );

end component;

signal Intermed : std_logic; -- вътрешен сигнал за предаване на тактовия сигнал

-------------------------------------------------------

signal Count_Int_Time_Hex : integer range 0 to 31;

signal HEX_IN : std_logic_vector(5 downto 0);

signal Seven_LED : std_logic_vector(6 downto 0);

-------------------------------------------------------

begin



in1: ClkStretcher port map(CLK=>BoardCLK,OutCLK=>Intermed,Reset=>Reset,Blink=>Blink, Count_Int_Time=>Count_Int_Time_Hex);



in2: TrafficLights port map(CLK=>Intermed,Reset=>Reset,Blink=>Blink,R1=>R1,Y1=>Y1,G1=>G1,R2=>R2,Y2=>Y2,G2=>G2,R_W1=>R_W1,G_W1=>G_W1,R_W2=>R_W2,G_W2=>G_W2,CAT_Change=>CAT,OutDouble=>OutDouble);



HEX_IN <= CONV_STD_LOGIC_VECTOR(Count_Int_Time_Hex, 6);



in3: HexToSevenSegment port map(HEX=>HEX_IN(3 downto 0), LED=>Seven_LED);



AA <= not Seven_LED(0);



AB <= not Seven_LED(1);



AC <= not Seven_LED(2);



AD <= not Seven_LED(3);



AE <= not Seven_LED(4);



AF <= not Seven_LED(5);



AG <= not Seven_LED(6);

end Structural;

- Актуализирайте съдържанието на файла чрез File => Save. 
В интерфейсната декларация на главния модул GeneralModule (entity...) са декларирани допълнително още няколко входно/изходни сигнала в сравнение с първата версия на проекта: сигнали за управление на седемсегментните индикаторни елементи, както и сигнали за управление на пешеходните светофари. Въведен е допълнително и брояч (декрементиращ брояч) със съдържание от тип integer, който ще задава  оставащото време до края на фазите червено/зелено на светофара.  
Промяна на кода в  модула за синхронизация на проекта   – ClkStretcher

В този модул, както и по-рано, е описан блокът за генериране на импулси за определяне на  интервалите от време за фазите на сфетофара от първия вариант на проекта, но в него сега е включена и схема за отброяване на една секунда, през която се декрементира стойността на брояча за продължителността на фазите на светофара.

- Кликнете двойно с мишката върху името на модула ClkStretcher в прозореца Sources на Project Navigator. Изтрийте текста и въведете следния VHDL- код, описващ новата версия на проектираното устройство:

library IEEE;

use IEEE.STD_LOGIC_1164.ALL;

use IEEE.STD_LOGIC_ARITH.ALL;

use IEEE.STD_LOGIC_UNSIGNED.ALL;

entity ClkStretcher is

port( 

 

   CLK : in std_logic; -- тактов сигнал на развойната платка

         

OutCLK : inout std_logic; -- продуциран изходен сигнал за продължителността

                                                                   -- на фазите на светофара


   Reset : in std_logic; -- сигнал за начална инициализация



   Blink : in std_logic; -- сигнал за мигащата жълта светлина




------------------
Count_Int_Time : inout integer range 0 to 31 -- сигнал за брояча, намаляващ  по

                                                                        --  време на   фазите 



);

end ClkStretcher;

architecture Behavioral of ClkStretcher is

signal enable1 : std_logic; -- стартира генерирането на дългия пулс

signal enable2 : std_logic; -- стартира генерирането на първия кратък пулс след всеки дълъг

signal enable3 : std_logic; -- стартира генерирането на втория кратък пулс след всеки дълъг

signal enable4 : std_logic; -- стартира секцията необходима за мигащата жълта светлина

signal counter1 : std_logic_vector(31 downto 0); -- определя дължината на дългия пулс

signal counter2 : std_logic_vector(24 downto 0); 
-- определя продължителността на първия тактов пулс

signal counter3 : std_logic_vector(24 downto 0); 
-- определя продължителността на втория тактов пулс 

signal counter4 : std_logic_vector(24 downto 0); 
-- определя честотата на мигане на жълтата светлина

---------------------------------------------

-- сигнал необходим за отброяване на 1 секунда, през която да

-- става декрементирането на брояча за фазата

signal time_counter : std_logic_vector(25 downto 0); 

---------------------------------------------   

begin

process(Reset, CLK, Blink)

begin

if(Reset = '1') then 
-- при начално установяване се активира първата секция генерираща дългия пулс


  enable1<='1';


  enable2<='0';


  enable3<='0';


  enable4<='0';


  counter1<=(others=>'0'); -- нулиране на всички броячи


  counter2<=(others=>'0');


  counter3<=(others=>'0');


  counter4<=(others=>'0');


  ------начално установяване-----


  time_counter <= (others=>'0');


  Count_Int_Time <= 10; 


  -------------------------------


  OutCLK<='0';

elsif(CLK'event and CLK='1') then

      if(enable1='1') then --  секция за активиране само на първия брояч 

           counter1 <= counter1+1;




  time_counter <= time_counter + 1; -- увеличаване на брояча за 1 секунда




-----------------------------------------------------




-- ако е отброена 1 секунда




if (time_counter  = x"2D6C00" ) then





time_counter <= (others=>'0');





-- декрементираме стойността на брояча за фазата





Count_Int_Time <= Count_Int_Time - 1;




end if;




-----------------------------------------------------




if(counter1<x"1FFFFFFF")then 





OutCLK<='1';  -- начало/високо ниво на OutCLK




elsif(counter1=x"1FFFFFFF" + 1) then 




enable1<='0';                   -- секцията се заключва и край на първия пулс




counter1<=(others=>'0'); -- нулиране на първия брояч




-------------




time_counter <= (others=>'0');  -- нулиране на брояча за 1 секунда.





Count_Int_Time <= 10;  -- инициализация на брояча за фазата




-------------





enable2<='1';                   -- стартиране на следващата секция




enable3<='0';   -- секцията е непозволена




enable4<='0';   -- секцията за мигащата жълта светлина е непозволена




OutCLK<='0';   -- OutCLK пада в ниско състояние



   else OutCLK<='0';
-- OutCLK пада в ниско състояние




end if;

       elsif(enable2='1') then --  секция за активиране само на втория брояч

              counter2<=counter2+1;

if (counter2<x"1000000") then OutCLK<='1'; -- начало/високо ниво на OutCLK



  elsif(counter2=x"1FFFFFF") then

            


enable1<='0'; -- секцията е непозволена




enable2<='0'; -- секцията се заключва и край на втория пулс

            


counter2<=(others=>'0'); -- нулиране на втория брояч

            


enable3<='1'; -- стартиране на следващата секция




enable4<='0'; -- секцията за мигащата жълта светлина е непозволена  




OutCLK<='0'; -- OutCLK пада в ниско състояние



  else OutCLK<='0'; -- OutCLK пада в ниско състояние


        end if;

   elsif (enable3='1') then --  секция за активиране само на третия брояч

        counter3<=counter3+1; 

if (counter3<x"1000000") then OutCLK<='1'; -- начало/високо ниво на OutCLK



elsif (counter3=x"1FFFFFF") then

            


enable3<='0'; -- секцията се заключва и край на третия пулс

            


counter3<=(others=>'0');  -- нулиране на третия брояч

            


enable1<='0'; -- секцията е непозволена

            


enable2<='0'; -- секцията е непозволена




enable4<='1'; -- секцията за мигащата жълта светлина е позволена




OutCLK<='0'; -- OutCLK пада в ниско състояние



else OutCLK<='0';  -- OutCLK пада в ниско състояние

             end if;

elsif(enable4='1') then -- секция за мигащата светлина и активиране само на четвъртия брояч


counter4<=counter4+1;

       ------- проверка дали сигнала отговарящ за мигащата жълта светлина е активен


       if(Blink='0') then -- Ако Blink е неактивен

            


 OutCLK<='0'; -- OutCLK пада в ниско състояние




enable1<='1'; -- секция 1 се отключва




enable2<='0'; -- секция 2 е заключена




enable3<='0'; -- секция 3 е заключена




enable4<='0'; -- секция 4 е заключена




counter4<=(others=>'0'); -- нулиране на четвъртия брояч


        elsif(Blink='1') then -- Ако Blink е активен



  


OutCLK<=counter4(24); -- продуцираме делител на честота


       end if;

        end if; -- край на секцията с enablе… 
    

   end if; -- край на секцията отговорна за Reset и CLK

end process;

end Behavioral;

- Актуализирайте съдържанието на файла чрез File => Save. 

Промяна на кода в  модула на проекта  ТrafficLights
В новата версия на устройството крайният автомат за управление на светлините генерира сигнали за управление на  пешеходните светофари, а също и сигнали за управление на блока със седемсегментните индикаторни елементи.  
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Нов вид на графа, описващ крайния автомат за управление на светофари ТrafficLights
- Кликнете двойно с мишката върху името на модула TrafficLights.vhd  в прозореца Sources на Project Navigator. Изтрийте текста и въведете следния VHDL- код, описващ новата версия на проектираното устройство:

library IEEE;

use IEEE.STD_LOGIC_1164.ALL;

use IEEE.STD_LOGIC_ARITH.ALL;

use IEEE.STD_LOGIC_UNSIGNED.ALL;

entity TrafficLights is


port (
                             

         CLK : in std_logic;  -- тактов сигнал, който ще идва от модула ClkStretcher




Reset : in std_logic; -- входен сигнал за начално установяване




Blink : in std_logic; -- сигнал отговарящ за мигащата жълта светлина



   R1 : out std_logic;   -- сигнал за червената светлина на светофар 1




Y1 : out std_logic;   -- сигнал за жълтата светлина на светофар 1




G1 : out std_logic;   -- сигнал за зелената светлина на светофар 1




R2 : out std_logic;   -- сигнал за червената светлина на светофар 2




Y2 : out std_logic;   -- сигнал за жълтата светлина на светофар 2




G2 : out std_logic;   -- сигнал за зелената светлина на светофар 2




----------------------




R_W1 : out std_logic;




G_W1 : out std_logic;




R_W2 : out std_logic;




G_W2 : out std_logic;




----------------------




CAT_Change : out std_logic;




----------------------




OutDouble : out std_logic -- сигнал, който повтаря CLK

         );

end TrafficLights;

architecture Behavioral of TrafficLights is


type state_type is (s1,s2,s3,s4,s5, s6, s7,s8); -- дефинираме потребителски тип


signal state , nextstate : state_type ;     -- представящ  състоянията на крайния автомат
begin

process1: process (CLK,Reset) -- процес необходим за началното установяване

begin

  if (Reset ='1') then 




state <=s1; 

  elsif (CLK='1' and CLK'event) then

      state <= nextstate;

  end if;

end process process1;

process2: process (state, Reset, Blink) -- процес отговарящ за преминаването                                   

begin



-- между отделните състояния и условията за това

case state is


when s1 => 
if (Reset='1') then







nextstate <= s1;














elsif
(Reset='0')  then 







nextstate <= s2;



         end if;

 
when s2 => nextstate <= s3; 

   when s3 => if(Blink='0') then


              nextstate <= s4;

              elsif(Blink='1') then

                 nextstate <= s7;





  end if;
  

   when s4 => nextstate <= s5; 


when s5 => nextstate <= s6; 


when s6 => if(Blink='0') then


              nextstate <= s1;

              elsif(Blink='1') then

                 nextstate <= s7;





  end if;



----------- секция, отговорна за мигащата жълта светлина 


when s7 => if(Reset='0' and Blink='1') then 


           nextstate <= s8;





  elsif(Reset='1') then 





  nextstate <= s1;





  elsif(Reset='0' and Blink='0') then


  





  nextstate <= s2;





  end if;


when s8 => if(Reset='0' and Blink='1') then 


           nextstate <= s7;





  elsif(Reset='1') then 





  nextstate <= s1;





  elsif(Reset='0' and Blink='0') then


  





  nextstate <= s2;





  end if;

end case;

end process process2;

process3 : process (CLK, state) -- процес необходим за индикацията

begin                           -- тук се посочва какво да се случи




 -- ако се намираме в даденото състояние

if (CLK='1' and CLK'event) then 

case state is

when s1 => R1<='1'; Y1<='0'; G1<='0'; R2<='0'; Y2<='0'; G2<='1'; R_W1<='0'; G_W1<='1'; R_W2<='1'; G_W2<='0'; CAT_Change<='0';

when s2 => R1<='1'; Y1<='0'; G1<='0'; R2<='0'; Y2<='1'; G2<='0'; R_W1<='1'; G_W1<='0'; R_W2<='1'; G_W2<='0'; CAT_Change<='0';

when s3 => R1<='1'; Y1<='1'; G1<='0'; R2<='1'; Y2<='0'; G2<='0'; R_W1<='1'; G_W1<='0'; R_W2<='1'; G_W2<='0'; CAT_Change<='1';

when s4 => R1<='0'; Y1<='0'; G1<='1'; R2<='1'; Y2<='0'; G2<='0'; R_W1<='1'; G_W1<='0'; R_W2<='0'; G_W2<='1'; CAT_Change<='1';

when s5 => R1<='0'; Y1<='1'; G1<='0'; R2<='1'; Y2<='0'; G2<='0'; R_W1<='1'; G_W1<='0'; R_W2<='1'; G_W2<='0'; CAT_Change<='1';

when s6 => R1<='1'; Y1<='0'; G1<='0'; R2<='1'; Y2<='1'; G2<='0'; R_W1<='1'; G_W1<='0'; R_W2<='1'; G_W2<='0'; CAT_Change<='0';

when s7 =>  if(Blink='1') then 

               R1<='0'; Y1<='1'; G1<='0'; R2<='0'; Y2<='1'; G2<='0'; R_W1<='0'; G_W1<='0'; R_W2<='0'; G_W2<='0'; CAT_Change<='1';





else





   R1<='1'; Y1<='0'; G1<='0'; R2<='0'; Y2<='0'; G2<='1'; R_W1<='0'; G_W1<='1'; R_W2<='1'; G_W2<='0'; CAT_Change<='0';





end if;


when s8 =>  if(Blink='1') then 

            R1<='0'; Y1<='0'; G1<='0'; R2<='0'; Y2<='0'; G2<='0'; R_W1<='0'; G_W1<='0'; R_W2<='0'; G_W2<='0'; CAT_Change<='0';





else





R1<='1'; Y1<='0'; G1<='0'; R2<='0'; Y2<='0'; G2<='1'; R_W1<='0'; G_W1<='1'; R_W2<='1'; G_W2<='0'; CAT_Change<='0';





end if;

end case;

end if;

end process process3;

OutDouble<=CLK;

end Behavioral;


- Актуализирайте съдържанието на файла чрез File => Save. 

Добавяне в проекта на модул  – HexToSevenSegment
Нов модул в проектас име  HexToSevenSegment ще описва цифров блок, кодиращ информацията, извеждана чрез  седем-сегментни индикаторни елементи. 

- Създайте/Добавете нов VHDL – модул в проекта чрез командите от главното меню Project => New Source..., в отворилия се прозорец New Source Wizard  изберете за тип на модула: VHDL Module, а за име: HexToSevenSegment
- В изведения прозорец за редактиране на текста на HexToSevenSegment.vhd се изобразява текстовата рамка на създадения модул с VHDL – описанието. (Ако прозорецът с текстовата рамка не е показан на екрана, кликнете двойно с мишката върху името на модула HexToSevenSegment в прозореца Sources на Project Navigator). 
- Изтрийте текстовата рамка и въведете следния VHDL код, описващ проектираното устройство:

library IEEE;

use IEEE.STD_LOGIC_1164.ALL;

use IEEE.STD_LOGIC_ARITH.ALL;

use IEEE.STD_LOGIC_UNSIGNED.ALL;

entity HexToSevenSegment is

port(


HEX:   in    STD_LOGIC_VECTOR (3 downto 0);

             LED:   out   STD_LOGIC_VECTOR (6 downto 0)


 );

end HexToSevenSegment;

architecture Behavioral of HexToSevenSegment is

begin


with HEX Select

   LED <= "1111001" when "0001",   --1

     
 "0100100" when "0010",   --2

          
"0110000" when "0011",   --3

          
"0011001" when "0100",   --4

          
"0010010" when "0101",   --5

          
"0000010" when "0110",   --6

          
"1111000" when "0111",   --7

          
"0000000" when "1000",   --8

          
"0010000" when "1001",   --9

          
"1000000" when others;   --0

end Behavioral;

- Актуализирайте съдържанието на файла чрез File => Save и изпълнете процесите на проектиране на устройството (от Generate Programming File...). 

След това  включване на модул и изпълнени процеси на проектиране, прозорецът Sources на развойната среда, показващ модулите на проекта, ще изглежда така:
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- За да можете да стартирате работата и проверите функционирането на новата версия на проектираното устройство върху зададения CPLD – чип върху развойна платка, задайте нови ограничения в работата на развойната среда при работата й. Задайте новите изисквания за разполагане на входните и изходни сигнали на устройството върху точно определени изводи на чипа, така че тези сигнали да управляват или да бъдат управлявани от определени елементи (ключове, бутони, светодиоди) на платката. За тази цел в таблицата, която поддържа програмата Pace от развойната среда, трябва да назначите пинове на CPLD – чипа за допълнителните входно/изходни сигнали на новата версия на устройството.

- Активирайте в  прозореца Sources UCF – модула на проекта GlobalUcf.ucf, след което в прозореца Processes разширете User Constraints и от разширението кликнете двойно върху Assign Package Pins; 
- Попълнете колоната Loc(ation) на таблицата на програмата Pace с имената на изводите на чипа за допълнителните сигнали, както е дадена по-долу:
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- Активирайте главния VHDL – модул на проекта и стартирайте чрез Generate Programming File наново процесите на проектиране;
 - Заредете получения от развойната среда файл за конфигуриране GeneralModule.jed  с ново съдържание в CPLD – чипа на развойната платка чрез програмата ExPort.
      -  Проверете работата на имплементираното устройство върху развойната платка X-Board.
С помощта на зададеното по-горе чрез програмата PACE и файла GlobalUCF.usf разполагане на входно/изходните сигнали върху изводите на чипа, работата на проектираното и имплементирано устройството за управление на седем-сегментната индикация на светофарна уредба (GeneralModule) ще се управлява и контролира от следните елементи на платката:
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От функционирането на платката се вижда, че междинните фази на светофарите (“червено и жълто” и “жълто” ) продължават доста малко време. Опитайте да увеличите продължителността на тези фази 
чрез увеличаване на крайните стойности, до които достигат броячите  counter2  и counter3 в модула ClkStrecher . (Тези броячи определят продулжителността и интервала между двата кратки импулса от тактовата поредица, синхронизираща управляващото устройство за светофарите).
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